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Preface

This User Guide is been implemented by Boot & Work, S.L. working
under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operating, to
functions, and to the technical data of the signal modules, power supply modules and
interface modules.

Intended Audience
This User Guide is intended for the following audience:

e Persons in charge of introducing automation devices.
e Persons who design automation systems.

e Persons who install or connect automation devices.

e Persons who manage working automation installation.

& Warnings:

e Unused pins should not be connected. Ignoring the directive may damage the
controller.

e Improper use of this product may severely damage the controller.

e Refer to the controller’s User Guide regarding wiring considerations.

e Before using this product, it is the responsibility of the user to read the product’s User
Guide and all accompanying documentation.

e Maintenance must be performed by qualified personnel familiarized with the
construction, operation, and hazards involved with the control.

e  Maintenance should be performed with the control out of operation and
disconnected from all sources of power.

e Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

e The Spartan Arduino PLC is Open Type Controller. It is required that you install the
Spartan Arduino PLC in a housing, cabinet, or electric control room. Entry to the
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housing, cabinet, or electric control room should be limited to authorized personnel.
Failure to follow these installation requirements could result in severe personal injury
and/or property damage. Always follow these requirements when Spartan Arduino
PLC.

e Incase of installation or maintenance of the Spartan PLC please follow the instructions
marked in the Installation and Maintenance section.

e Do not disconnect equipment when a flammable or combustible atmosphere is
present. Disconnection of equipment when a flammable or combustible atmosphere is
present may cause a fire or explosion which could result in death, serious injury and/or
property damage.

Avertissements:

e Les broches non utilisées ne doivent pas étre connectées. Ignorer la directive peut
endommager le controleur.

e Une utilisation incorrecte de ce produit peut endommager gravement le controleur.

e Reportez-vous au Guide de I'utilisateur du controleur pour les considérations de
cablage.

e Avant d’utiliser ce produit, il incombe a I'utilisateur de lire le Guide de I'utilisateur du
produit et la documentation qui I’accompagne.

e La maintenance doit étre effectuée par personnel qualifié familiarisé avec la
fabrication, le fonctionnement et les dangers liés au contréleur.

e La maintenance doit étre effectuée avec I'’équipement hors service et déconnectée de
toutes les sources d'alimentation.

e Faites attention lors de |'entretien des composants sensibles a |'électricité statique.
Les recommandations du fabricant pour ces composants doivent étre suivies.

e L['automate Spartan Arduino PLC cest contréleur de type ouvert. |l est nécessaire
d'installer I'automate Spartan Arduino PLC dans un boftier, une armoire ou une salle
de controle électrique. L'accés au boitier, a I'armoire ou a la salle de commande
électrique doit étre limité au personnel autorisé. Le non-respect de ces exigences
d'installation peut entrainer des blessures graves et/ou des dommages matériels
importants. Respectez toujours ces exigences lors de l'installation de I'automate
Spartan Arduino PLC.

e Encas d'installation ou de maintenance du Spartan PLC, veuillez suivre les instructions
indiquées dans la section Installation et Maintenance.

e Ne débranchez pas I'équipement en présence d'une atmosphére inflammable ou
combustible. La déconnexion de I'équipement en présence d'une atmosphere
inflammable ou combustible peut provoquer un incendie ou une explosion pouvant
entrainer la mort, des blessures graves et/ou des dommages matériels.
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Application Considerations and Warranty

Read and Understand this Manual

Please read and understand this manual before using the product. Please consult your
comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED.
THEY SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR
PROTECTIVE DEVICE FOR ENSURING SAFETY OF PERSONS, AS THEY ARE
NOT RATED OR DESSIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY
WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESSIGNED
TO ADDRESS THE RISKS, NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE
PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE
OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or
standards that apply to the combination of products in the customer’s application or use
of the product.

The following are some examples of applications for which particular attention must be
given. This is not intended to be an exhaustive list of all possible uses of the products,
nor is it intended to imply that the uses may be suitable for the products:

e Systems, machines, and equipment that could present a risk to life or property.

¢ Nuclear energy control systems, combustion systems, railroad systems,
aviation systems, medical equipment, amusement machines, vehicles, safety
equipment, and installation subject to separate industry or government
regulations.

¢ Outdoor use, uses involving potential chemical contamination or electrical
interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party
certification documents identifying ratings and limitations of use that apply to the
products. This information by itself is not sufficient for a complete determination of the
suitability of the products in combination with the system, machine, end product, or
other application or use.



Ref. 017001001200 Rev.0: 18-03-20

Intended use or of Industrial Shields products

Consider the following:

Industrial Shields products should only be used for the cases of application foreseen in
the catalogue and the associated technical documentation. If third-party products and
components are used, they must have been recommended or approved by Industrial
Shields.

The correct and safe operation of the products requires that your transport, storage,
installation, assembly, operation and maintenance have been carried out in a correct It
must respect the permissible ambient conditions. You should also follow the indications
and warnings that appear in the associated documentation.

The product / system dealt with in this documentation should only be handled or
manipulated by qualified personnel for the task entrusted and observing what is
indicated in the documentation corresponding to it, particularly the safety instructions
and warnings included in it. Due to their training and experience, qualified personnel
are in a position to recognize risks resulting from the handling or manipulation of such
products / systems and to avoid possible hazards.

Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing
purposes, even when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in
determining suitability and does not constitute a warranty. It may represent the result of
INDUSTRIAL SHIELDS'’s test conditions, and the users most correlate it to actual
application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS
Warranty and Limitations of Liability.

Change in Specifications

Product specifications and accessories may be changed at any time based on
improvements and other reasons.

It is our practice to change model numbers when features are changed, or published
ratings or when significant construction changes are made. However, some
specifications of the products may be changed without any notice. When in doubt,
special numbers may be assigned to fix or establish key specifications for your
application on your request. Please consult with your INDUSTRIAL SHIELDS
representative at any time to confirm actual specifications of purchased products.
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Errors and Omissions

The information in this document has been carefully checked and is believed to be
accurate; however, no responsibility is assumed for clerical, typographical, or
proofreading errors, or omissions.

The control and drive components of an Industrial Shields PLC are approved for
industrial and commercial use in industrial line supplies. Their use in public line
supplies requires a different configuration and/or additional measures. These
components may only be operated in closed housings or in higher-level control
cabinets with protective covers that are closed, and when all of the protective devices
are used. These components may only be handled by qualified and trained technical
personnel who are knowledgeable and observe all of the safety information and
instructions on the components and in the associated technical user documentation.
When carrying out a risk assessment of a machine in accordance with the EU
Machinery Directive, the machine manufacturer must consider the following residual
risks associated with the control and drive components of a PDS.

1. Unintentional movements of driven machine components during commissioning,
operation, maintenance, and repairs caused by, for example: — Hardware defects
and/or software errors in the sensors, controllers, actuators, and connection technology
- Response times of the controller and drive — Operating and/or ambient conditions not
within the scope of the specification — Condensation / conductive contamination -
Parameterization, programming, cabling, and installation errors — Use of radio devices /
cellular phones in the immediate vicinity of the controller — External influences /
damage.

2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by,
for example: — Component malfunctions — Software errors — Operating and/or
ambient conditions not within the scope of the specification — External
influences / damage.

3. Hazardous shock voltages caused by, for example: - Component malfunctions -
Influence of electrostatic charging — Induction of voltages in moving motors — Operating
and/or ambient conditions not within the scope of the specification — Condensation /
conductive contamination — External influences / damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose
a risk to people with a pacemaker, implants or metal replacement joints, etc. if they are
too close.

5. Release of environmental pollutants or emissions as a result of improper operation
of the system and/or failure to dispose of components safely and correctly.
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Warranty and Limitations of Liability

Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in
materials and workmanship for a period of one year (or other period if specified) from
date of sale by Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY,
EXPRESSED OR IMPLIED, REGARDING MERCHANABILITY, NON-
INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE OF THE PRODUCTS.
ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE
HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE
REQUIREMENTS OF THEIR INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS
ALL OTHER WARRANTIES, EXPRESS OR IMPLIED

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT,
OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN
ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS
BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONISBLE FOR WARRANTY,
REPAIR OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL
SHIELDS’S ANALYSIS CONFIRMS THAT THE PRODUCTS WERE PROPERLY
HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO
CONTAMINATION, ABUSE, MISUSE, OR INAPPROPIATE MODIFICATION OR
REPAIR.
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1. Spartan Arduino PLC: General Features

Supply Yaoltage

24 \cc

1/Os

Digital
Analog

COMPACT SPARTAN ARDUINO PLC

Fuse protection (2.5A)

Input Voltage 12 to 24Vdc Polarity protection
Input rated voltage 24 Vde
Rated Power 30w
| Max. 1,5A
Size 100x45x115
Clock Speed 16MHz
32KB of which 4KB are used by
Flash Memory bootloader
SRAM 2.5KB
EEPROM 1KB
o 12C -- USB -- RS485 (Half
Communications Duplex)-- SPI - TTL RS485
TOTAL Input points 8
TOTAL Output points 8
0to 10Vac
Input Impedance: 39K
Separated PCB ground
Rated Voltage: 10Vac
An/Dig Input 10bit
(0-10Vce) 7 to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation
Rated Voltage: 24 Vdc
* Interrupt isolated Input 710 24vdc 7 to 24vdc
HS I min: 2to 12 mA | min: 3/6 mA
Galvanic Isolation Sel arated PCB around
(24Vcce) Rated Voltage: 24Vdc P 9

Analog Output 8bit
(0-10Vce)

0 to 10Vac
I max: 20 mA
Separated PCB ground
Rated Voltage: 10Vac

Digital Isolated Output
(24Vcce)

5to 24Vdc
I max: 70 mA
Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

Imax 24Vdc: 410 mA

PWM lsolated Output
8bit (24Vce)

5 to 24Vdc
I max: 70 mA
Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

PWM lIsolated
Output 8bit (24vcc)

Expandability

12C — RS485( Half Duplex ) — SPI
—-TTL

Reference

017001001200

10
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2. Technical Specifications

2.1

General Specifications:

Rev.0: 18-03-20

Power supply
voltage

DC power supply

12 to 24Vdc ==

Operating
voltage range

DC power supply

11.4t025.4Vdc ===

Power

consumption DC power supply 30VAC max.
External Power supply voltage 24Vde ===
power supply
Power supply output 200 mA

capacity

Insulation resistance

20MQ min. at 500Vdc between the AC terminals and the protective ground

terminal.

Dielectric strength

2.300 VAC at 50/ 60 Hz for one minute with a leakage current of 10mA
max. Between all the external AC terminals and the protective earth

terminal.

Shock resistance

80m/s? in the X, Y and Z direction 2 times each.

Ambient temperature (operating)

0°to 60°C

Ambient humidity (operating)

10% to 90% (no condensation)

Ambient environment (operating)

With no corrosive gas

Ambient temperature (storage) -20° to 60°C
Power supply holding time 2ms min.
350g max.

Weight

2.2 Performance Specification:

Arduino Board

ARDUINO LEONARDO

Control method

Stored program method

1/0 control method

Combination of the cyclic scan and immediate refresh processing methods.

Programming language

Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform
composed of a programming language. “similar to the C”.
http://arduino.cc/en/Tutorial/HomePage

Microcontroller

ATmega32u4

Flash Memory

32KB of which 4KB are used by bootloader

Program capacity (SRAM) 2.5KB
EEPROM 1KB
Clock Speed 16MHz

11
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2.3

Symbology

Rev.0: 18-03-20

Table that includes all the symbology that is used in the serigraph of the Spartan Arduino PLC :

Svmbol Standard No. / Standard
y Standard Title Reference No. / Symbol Meaning
Symbol Title
IEC 60417 / : . .
EEEEEEE— : . Indicates that the equipment is
B EE Em Graphical symbols 5031/ Direct suitable for direct current only;
for use on Current to identify relevant terminals
equipment y
IEC 60417 / Indicates that the equipment is
Graphical symbols , suitable for alternating current
N for use on 5032 (/:Alternatmg only; to identify relevant
. urrent :
equipment terminals
IEC 60417 /
Graphical symbols 5130 / Pulse To _|dent|fy the _control by
for use on which a pulse is started.
. General
equipment
IEC 60417 / To identify an earth (ground)
Graphical symbols terminal in cases where
for use on 5017/ Earth, neither the symbol 5018 nor
. Ground . . :
equipment 5019 is explicily required.
IEC 60417 / , . .
Graphical symbols To identify the swﬂch by
means of which the signal
for use on 5115/ Signal lamp : )
. lamp(s) is (are) switched on or
equipment off

C€

Medical Devices

CE marking indicates that a
product complies with

Directive CE Marking licabl )
93/42/EEC applicable Euro_pean Union
regulations
ISO 7000/ , .
Graphical symbols Indlcates_a pqtentlal_ly _
; 0434B / hazardous situation which, if
or use on . . .
; Warning symbol not avoided, could result in
equipment q ; e
eath or serious injury
ISO 7000/
Grapf;hlcal symbols 5036 / Dangerous To indicate hazards arising
or use on
. Voltage from dangerous voltages
equipment

12
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3. Precautions

Read this manual before attempting to use the Spartan Arduino PLC and follow its descriptions
for reference during operation.

3.1 Arduino Board

The Spartan Arduino PLC include Arduino Leonardo Board as controller.

3.2 Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.3 General Precautions

The user must operate Spartan Arduino PLC according to the performance specifications
described in this manual.

Before using Spartan Arduino PLC under different conditions from what has been specified in
this manual or integrating Spartan Arduino PLC to nuclear control systems, railroad systems,
aviation systems, vehicles, combustion systems, medical equipment, amusement machines,
safety equipment and other systems, machines, and equipment that may have a serious
influence on lives and property if used improperly, consult your INDUSTRIAL SHIELDS
representative. Ensure that the rating and performance characteristics of Spartan Arduino PLC
are sufficient for the systems, machines, and equipment, and be sure to provide the systems,
machines, and equipment double safety mechanisms. This manual provides information for
programming and operating the Spartan Arduino PLC.

13
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4. Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C
language. They can also be programmed using directly C but it is much easier working with
Arduino IDE as it provides lots of libraries that helps in the programming.

Furthermore Industrial Shields provides boards for programming the PLCs much easier.
Basically it is no needed to define the pins and if that pins are inputs or outputs. Everything is
set up automatically if using the boards.

In order to install Industrial Shields boards, these are the steps that must be followed.
Requirements:
Arduino IDE 1.8.0 or above (better to have always the latest version).
Steps:
1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.

Preferences X

Settings  Network

Sketchbool location:

C:\Users\Albert\Documents\Arduino Browse
Editor language English (English) ~| (requires restart of Arcuina)
Editor font size: 15

Interface scale: Automatic | 100 5 %  (requires restart of Arduino)

Show verbose output during: compilation upload
Compiler warnings: None v

[ pisplay line numbers

[[JEnable Code Folding

Verify code after upload

[ Use external editor

Check for updates on startup

Update sketch files th new extension on save (.pde -> .ina)
Save when verifying or uploading

Additional Boards Manager URLs: |http://apps. industrialshields. com/main/arduina/boards /package_industrialshields_inde:| [
More preferences can be edited directly in the file
C:\Users\Albert\AppData\L ocal\Arduino15\preferences. bt

(edit only when Arduing is not running)

OK Cancel

2. In Additional Boards URLs write the following:

http://apps.industrialshields.com/main/arduino/boards/package industrialshields index.json

3. Press OK to save the changes.

14
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4. Goto: Tools -> Board:

Rev.0: 18-03-20

-> Boards Manager

@ sketch mar1sa | Arauino 180

File Edit Sketth Tools Help

Auito Form at
Archive Sketch

Fix Encoding & Reload
Serial Monitor

Serial Plotter

WIFi 101 Firmvrare Updlater
Board: "M-Duine family”
Inchastiial Shaeldls: “M-Dy

Get Board Infa.

Programm er: “Arduing as ISP
Burn Bootloader

5. Search for industrialshields.

Archiine Yiin
Arduine/Genuno Uno

Arduing Duemilanove or Diecimila
Arduine Nano

Arduina/Genuine Mega o Mega 2560
Arduino Mega ADK

Arduine Leonardo

Arduino Leonardo ETH
Archine/Genuano Micro

Arduine Esplora

Arduine Mini

Arduino Ethemet

Arching Fio

Ardune BT

LilyPad Arduino USE

LilyPad Arduina

Arduine Pro o Pro Mini

Arduine NG or older

Arduine Robot Control

Arduina Robot Motor

Adatuit Circuit Playground
Arduine Yun Mini
Arduing Industrial 101
Linino One

Archuine Uno WiFi
Induswial Shields be
Ardbox family
M-Duina family

& Boards Manager

Type All ~ | industrialshields

industrialshields

Boards included in this package:
ARDBOX family, M-Duina family.
Qnline help.

More info

i~ | Install

Close
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6. Click install (selecting the latest version).

Following this steps you will be able to use now the Industrial Shields Boards:

WIFi101 / WiFININA Firmware Updater

| Bo “Arcoox WITY/BT tamily” 3 Bods Manager.
Vade: “Ardbo Ansiog HF+ w/ H RS-232 WIF/BT

Also there are some examples of programming in File -> Examples -> Spartan Arduino PLC.
Furthermore there are some extra libraries that can be found in Industrial Shields github.

https://github.com/IndustrialShields/

16
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5. How to connect PLC Arduino to PC
- Connect USB port from PLC to PC.

NOTE:
Ardbox Family uses micro USB cable.

- Open Arduino IDE interface:
- Select Industrial Shields boards -> Spartan Arduino PLC

- Select correct port.

@ sketch mar16a | Arduing 120 - o x
File Edit Sketzh Tools Help

Ao Format culeT

Archive Sketch

Fix Encoding & Reload

Serial Morstor Culshitts

Senial Plotter Cirl+Shiftsl
WAFI101 Firmveare Updatee
Boarct “Ardbox family”
Inchrstrial Shields: “Ardbox Analog™
‘1 bt §  senal ports
b Y GetBowdinto COMI3 (Arckiing Leanarda)

Prograsm mes: “Arduno as ISP
Burn Boasoader

17
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6. How to connect PLC to power supply
- Spartan Arduino PLC 12-24Vdc supplied. IMPORTANT: The polarity IS NOT REVERSAL!
- Make sure that the live and GND connector of the power supply match the PLC.

- Make sure that the power supply mains output is not higher than 24Vdc.

JE—
B L

| I e—— |
- Suggested power suppliers

Compact DIN rail power supply. Assembled on 35mm

. —— ('f
DIN Rail: m |
-12Vvdc / 24Vdc T il
2.5A - I
-30W ... "

o

Industrial Shields power supplies provide parallel Sy
operation, overvoltage protection, and overcurrent %
protection. There is a LED inductor for power status, EN“

the power supply is certified according to UL.

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types
of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC
61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-
1.

WARINING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of
the equipment must be separated from the dangerous voltage cables.

18
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7. Ardbox Analog I/0 pinout:

7.1  Zone Connections
LEFT ZONE
5 £
= o c
%3 o S
o g 5 o
Sa B 5
<O < s
A0.6! 3 Analog Out
A0.5! 5 Analog Out
A0.41 6 Analog Out
A0.3t 9 Analog Out
A0.21 10 Analog Out
A0.11 11 Analog Out
A0.0t 13 Analog Out
Q0.92 1 Digital Output
Q0.82 0 Digital Output
Q0.7 7 Digital Output
Q0.6 3 PW M/digital Output
Q0.5 5 PW M/digital Output
Q0.4 6 PW M/digital Output
Q0.3 9 PW M/digital Output
NC - Not Connected
NC - Not Connected
Q0.0 13 PW M/digital Output
GNDCOM - GND
24VCOM - Power Supply

1y il
00 e [
on' =
(0.4 3= E
(0 2 &
00 <
(i1 =
Q0
AlLE
A5
Al 4
Al
NC =
AL

£l
(1A
ooe
a7
|.||'.
0
Q0.4
(0]}
[ LD
ML 4
[RLIN ]
GNDC om
4y Com
ND | 2
24V _|®"

Rev.0: 18-03-20

LEFT ZONE

Switch config*
(see section 8 for Communications

configuration. Enabling Communications

disables some 1/0s)

Analog Outputs pins

Digital Outputs pins

Power supply connectors
(24Vdc - GND)

19
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RIGHT ZONE
5 | £ &2
X 8 o o 5 S
o c c S
ac 5 5 3]
T s S S0 c
= O =4 =] S
<O < x [
A+L2 - - RS485(A)
B-12 - - RS485(B)
NC - - Not Connected
NC - - Not Connected
SCL-PIN3? 3 3 SCL(I12C)
SDA-PIN2! 2 2 SDA(I2C)
NC - 4 Not Connected
NC - 8 Not Connected
5V - - 5Vout DC
RESET - - RESET
SCK - - SPI
MOSI - - SPI
MISO - - SPI
10.7 18 18 Analog/Digital Input
10.6 19 19 Analog/Digital Input
10.5 20 20 Analog/Digital Input
10.4 21 21 Analog/Digital Input
10.3 22 22 Analog/Digital Input
10.2 23 23 Analog/Digital Input
NC - - Not Connected
NC - - Not Connected
10.1 12 12 Digital Input
10.0t 2 2 Digital interrupt

Rev.0: 18-03-20

! See section 8 to enable these connections

2 See section 9 to enable these connections
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RIGHT ZONE [ * LEFT ZONE
] == FF =
EEDE
= FF *
82 | SDA-D2/100
. . S22 | SCL-D3/00.5
Switch config* 8 &85 Switch config*
(see section 8 for Communications _ 4 (see section 8 for Communications
configuration. Enabling Communications i configuration. Enabling Communications
disables some 1/0s) il 2|k disables some 1/0s)
i _.. ‘-_|
5
CL-PIN
= [a-PINe
Communications pins : i Communications pins
=l = .
= o
b
Digital/Analog Inputs 10,9 Digital/Analog Inputs
[0.8
10.7
D&
0.5
10.4
"\._‘ '_ \
NC i
0
I
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HS*: Hardware Serial
SS*: Software Serial

Rev.0: 18-03-20

1 See section 8 to enable these connections

2 See section 9 to enable these connections

NOTE: These Pins are not connected.

DEFAULT SERIGRAPHY CORRECT SERIGRAPHY
. SDA-PIN2 SDA-PIN2
SCL-PIN3
4| spaping NC NC
- NC NC NC
NC
GND GND GND
5V
L
USTr e
Config switch * )
(see section 8 for communications Input / Output Power LED Arduino Reset

configuration)

button

22




Ref. 017001001200

8. Switch configuration

8.1

LEFT ZONE.

Communications and inputs/outputs can not work simultaneously.

General Switches Configuration

Rev.0: 18-03-20

LEFT ZONE OFF ON
SWITCH OFF ON
ON
ON SELECT OFF
OFF SELECT ON
ON SELECT OFF
OFF SELECT SDA-D2/10.0
SCL-D3/Q06
SDA-D2/10.0* | SDA-D2 | 10.0
SCL-D3/Q0.6* | SCL-D3 0.6
Q Q OFF ON

6. Always at ON position.

5. Always at OFF position.

4. Always at ON position.

3. Always at OFF position.

2. SDA-D2/10.0 — Choosing between SDA (12C) / Pin2 and 10.0. If this switch is ON, the 10.0 input
will be enabled and the SDA / Pin3 will be disabled. If this switch is OFF, the SDA / Pin2 will be

now available and 10.0 disabled.

1. SCL-D3/Q0.6 — Choosing between SCL (12C) / Pin3 and QO.6. If this switch is ON, the Q0.6

input will be enabled and the SCL / Pin3 will be disabled. If this switch is OFF, the SCL / Pin3 will
be now available and Q0.6 disabled.
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TOP ZONE

Note: Don’t change the switch position

OFF

ON

OFF
ON
OFF
ON

4. Always in OFF position.
3. Always in ON position.
2. Always in OFF position.

1. Always in ON position.

In function of the switch position you can select for ON Digital Output and for OFF Analog

Output.

RIGHT ZONE SWITCH

OFF

ON

HD - FD
Q0.6
Q0.5
Q0.4

Q0.3
Q0.2
Q01
Q0.0

OFF

OM

4. Always in OFF position.
3. Always in OFF position.
2. Always in OFF position.

1. Always in OFF position.

4. Always in OFF position.
3. Not Connected.

2. Not Connected.

1. Always in OFF position.
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8.2 RS- 485 Switch configuration

TOP

OFF
ON
OFF
ON
LEFT ZONE
SWITCH CONFIGURATION
MODE
ON
OFF
ON
OFF

RS-485 TOP ZONE: In order to enable the RS-485 protocol the TOP ZONE must be

ZONE configured as it is shown in the table.
MODE | Although the switch serigraphy is only referenced to RS-485.

RS-485 LEFT ZONE: In order to enable the RS-485 communication
protocol it is necessary that the switches of the left zone are

configured as it is showed in the table.

The ones marked with “-“ mean that they don’t affect the RS-485

communication protocol

8.3  [2C Switch configuration

TOP ZONE LEFT ZONE
SWITCH MODE SWITCH MODE

Q0.8 RS-485 DE
RS485/RS232 HS D18/10.9

(RO) RS-485 RE

Q0.9 D19/10.8

SDA-D2/10.0 OFF

RS485/RS232 HS

()] SCL-D3/Q0.6 OFF

12C: Enable SCL and SDA connections (direct Arduino pins) with configuration switches. 10.0
and Q0.6 will not be available. In order to implement this communication a 4.7kQ pull-up

resistor (IS.ACI2C-4.7K) is required.


http://www.industrialshields.com/Industrial%20Pull%20UP%20I2C%20connection
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9. Ardbox - Arduino I/0s 5V pins

The Ardbox has some of the Leonardo board pins available. These pins can be programmed
according to Arduino features such as I/Os operating at 5V or any additional features present
in the pins (for example I12C communication in pins SCL and SDA). As this pins are directly
connected to the Arduino Leonardo board they are not as well protect as the normal inputs.
These pins are mainly meant to be used as prototyping.

Ardbox terminal Arduino pin
SCL-Pin3 3
SDA —Pin 2 2
MISO 14
SCK 15
MOSI 16

*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than 5V.
These terminals provide direct access to the Leonardo board.

A part from the switch configuration there are some special conditions depending on these 5V.
Now it is going to be shown the considerations to operate with these pins.

9.1 12C pins - SDA/SCL

The 12C protocol is meant to work in a pull-up configuration. The 12C pins in the Arduino
Leonardo are not pull-up, so in order to work with the 12C an external pull-up resistor is
required. If it is meant to work as a GPIO at 5V, the switches must be set as 12C, (section 8).

These pins are not stablished with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be stablished an external pull-up or pull-down circuit in order to correctly work with
these pins.

9.1 Pin2/Pin3

These pins are only referred to the inputs 10.5/10.6. If the switch configuration is in OFF
position the pins Pin 2/Pin 3 will be available.

These pins are not stablished with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
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must be stablished an external pull-up or pull-down circuit in order to correctly work with
these pins.

10. 1/0 technical details

Digital Output Waveform

[T o —
v

DIGITAL OUT

DIGITAL OUT

ARDLINO-OUT

[ZFEEE 5. @il M ZBEus CH1 % Z@Eml)
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PWM Waveform

Analog Out Turn-off

Rev.0: 18-03-20
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——

b 4

ANALDG OUT

Analog/Digital Input Turn-on

T JECEL,

Rev.0: 18-03-20
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11.

Typical Connections

Ferrite KITA

0

ae,

Rev.0: 18-03-20

SHIELDED CABLE E%

SHIELDED CAEBLE

SM224v
GND

0-10V

£,

n

errite KITA

\

@

0.7

SHIELDED CABLE 4 Downboad e MOUSNO LAYOUT: \
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o1V

—C%)— 0.7

Ferrite KITA
A

GND

e )
el /4 B ocoeTamecom
SHIELDED CABLE g‘."“'"m“ﬂm \

SHIELDED CABLE

ﬂ 512724V jB
A o ALWAYS

CONNECTED
Ferrite Kl @
.,‘c 0 ) e
A8

7
SHIELDED CABLU_‘_J _,,:;:"N_..,,“,;m\
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SHIELDED CABLE o rrite KIT)

GND
224V B—

SHIELDED CABLE

* See the switch
configutanon (ON)
e &
ALWAYS
Jn CONNECTED
Ferrite KITA ®
GND -
ﬁl I' VOUT = 0/ Vde

SHIELDED CABL

)

\z J
SHIELDED CABLE

32
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/”#_'_‘\
§ ANALOG OUTPUT P
* Analog Outs no led
indicator
AN * See the switch

configutarion (OFF)

GND | =
CL 010V
o AT

SHIELDED CABLE

Ferrite KITA oo
GND

s POWER
224V E ANALOG OUT
SHIELDED CABLE mnmum
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12. Connector details

The connector inside the PLCs that mounts on the PCB is MC 0,5/10-G-2,5 THT — 1963502
from Phoenix contact. MC0,5/10-G-2,5THT

For I/0O and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix
contact. FK-MC 0,5/10-ST-2,5

Connection details:

Article reference  MC 0,5/10-G-2,5 THT
Height 8,1Imm
Pitch 2,5mm
Dimension 22,5mm
Pin dimensions 0,8x0,8mm
Pin spacing 2,50mm
Article reference FK-MC 0,5/10-ST-2,5
Rigid conduit section min. 0,14 mm?
Rigid conduit section max. 0,5 mm?
Flexible conduit section min. 0,14 mm?
Flexible conduit section max. 0,5 mm?
Conduit section AWG/kcmil min. 26
Conduit section AWG/kcmil max. 20

34


https://www.phoenixcontact.com/online/portal/us?uri=pxc-oc-itemdetail:pid=1963502&library=usen&tab=1
https://www.phoenixcontact.com/online/portal/us?uri=pxc-oc-itemdetail:pid=1881406&library=usen&tab=1#General

Ref. 017001001200

13.

45mm width

- DIN rail mounting:

&

14

Rev.0: 18-03-20

Spartan Arduino PLC Dimensions:

Profilato o cappello TH 35-7,5 Profilato o coppello TH 35-15
Top hat rail TH 35-7,5 Top hat rail TH 35-15
15 5
0
755
1=0.04
15°
[ RO8
R12
— 303 . R0S
4 _..L 1004
v Sezione A/ Section A k12
0.3 max -~ 22 min. finoa / To 2,5 max
?" -

B Sezione A / Sedtion A
CARATTERISTICHE METODO  UNMA"  BLEND FEATURES TEST UNITS BLEND
DI MISURA _PC/ABS METHOD PU/ABS
Meccaniche Resishrwn o ASTM D638 MPo 88 Mechanical test Resistonce b tensik yield ASTMD638 MRy L]
Residhioo o tzioneo mttwg KT D638  MPo £ Tonsloshength ASTMD638 MRy %
Alyngomento o rotin KSTHDE8 % 9 Utimonte elongot ASTMDE3S % 9
Moduloin fesione KTADT0  MPo 2894 Ping modulus ASTHDT0 MRy 289%
Provo I20d conintoglio 5018014 Xy 55 aod test niched 1S0160/14  Xyim" 55
Termiche Temp. di nmmolimento Viot, medoB ST DIS2S  °C 114 Thermal test Vit sodbening 1 g meth MO 1 114
Tomperotvm Rito 1.81 MRy KTHOE  °C LA Rekecting temperctue 1 81 WPg ASTHDB8 9
Fisiche Peso o KUADT92  gfand 121 Physical test  Spaciic guvity ASTHDT?  gv'and 1.2
Rin o KUADISS % 0408 Mook shinkage ASTHD9SS % 0406
Ml Flow Index 260°C - 98N SUADIZ8 10" 1 Mkt Flow Index 260°C - 98 ASTMDIZ38  gi10’ 11
Comportamento Aukesinguerzs (i di pesor) I} V-0(08) Flame test Seff etinguisher hickness in mm) o4 - V-0(0.8)
allo fiomma _Fib Incandescen 37 mm %521 °C 960 Inndesients thieod 32 mm 169521 C 960

Ialtronic si riserva il diritto di modificare il materiole con cui realizzn i propei prodotti

senzo obbligo di preawiso.

Ialtronic con operate ony change of the moterials without being obliged to forewarn.
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14.Installation and Maintenance

Notes for installation:

- Theinstallation position should be free from the following: dust or oil smoke,
conductive dust, corrosive or flammable gas, high temperature, condensation, and
rain.

- Besides, vibration and impact also affect the PLC normal operation and shorten its
lifespan; electric shock, fire or misact also damages the product. During drilling or
wiring, prevent the metal particles or wire segments from falling into the PLC casing,
which may cause fire, fault or misact.

- After the PLC installation, clean the ventilation duct to prevent blocking, which may
cause bad ventilation, or even fire, faults or misact.

- Do not online connect, plug or unplug cables, which is apt to cause electric shock or
damage the circuit. Installation and wire connection must be firm and reliable. Poor
connection could cause misact.

- Use shielded twisted pair for the 1/0 of high frequency signal and analog signal to
improve system IMS.

The installation environment should be free from dust, oil smoke, conductive particle,
corrosive or flammable gases, high temperature, condensation, and rain.

Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan.
It is recommended to install the PLC, together with the matching switches and contactors,
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high
ambient temperature or heat generating equipment nearby, install forced convection
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring,
prevent the metal particles or wire segments from falling into the PLC casing, which may
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent
blocking, which may cause bad ventilation, or even fire, faults or misact.

The only way to disconnect the equipment from the electrical network is by removing the
connectors that feed the equipment. Once installed in the electrical cabinet it is very
important to ensure the power connectors for proper operation.

Separate the Spartan Arduino PLC from heat, high voltage and electrical noise:

Always separate the devices that generate high voltage and high electrical noise from the
Spartan Arduino PLC. When configuring the layout of the Spartan Arduino PLC inside your
panel, consider the heat-generating devices and locate the electronic-type devices in the
cooler areas of your cabinet. Reducing the exposure to a high-temperature environment
will extend the operating life of any electronic device. Consider also the routing of the
wiring for the devices in the electric cabinet. Avoid placing low-voltage signal wires and
communications cables in the same tray with AC power wiring and high energy, rapidly-
switched DC wiring.
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Provide adequate clearance for cooling and wiring Spartan Arduino PLC. Is designed for natural
convection cooling. For proper cooling, you must provide a clearance of at least 25 cm above
and below the devices. Also, allow at least 25 cm of depth between the front of the modules
and the inside of the enclosure.

Notes for maintenance:

A well-planned and executed maintenance program is essential to the satisfactory operation of
solid-state electrical equipment. The kind and frequency of the maintenance operation will
vary with the kind and complexity of the equipment as well as with the nature of the operating
conditions. Maintenance recommendations of the manufacturer or appropriate product
standards should be followed.

The following factors should be considered when formulating a maintenance program:

- Maintenance must be performed by qualified personnel familiar with the construction,
operation, and hazards involved with the control.

- Maintenance should be performed with the control out of operation and
disconnected from all sources of power.

- Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

- Ventilation passages should be kept open. If the equipment depends upon auxiliary
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when
necessary) should be made of these systems.

- The means employed for grounding or insulating the equipment from ground should
be checked to assure its integrity.

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks,
should be removed according to the manufacturer's instructions, if provided;
otherwise, the manufacturer should be consulted. Care must be taken to avoid
damaging any delicate components and to avoid displacing dust, dirt, or debris in a
way that permits it to enter or settle into parts of the control equipment.

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and
dirt should be removed from the top of the enclosures before opening doors or
removing covers.

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g.,
polychlorinated biphenyls (PCBs) found in some liquid filled capacitors) must be
disposed of as described in Federal regulations.

Safety rules for maintenance personnel

Consider the following steps to follow. A false manoeuvre could be the cause of an
accident or material damage.

Do not disassemble or modify the modules. This could lead to breakdowns or
malfunctions and could lead to injuries or fire.

- All types of radio communication devices, including mobile phones and personal
handy-phone systems (PHS), must be kept more than 25cm away from the PLC in all
directions. Failure to observe this precaution exposes malfunctions caused by excess of
temperature.
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- Disconnect the external power supply of the system (on all phases) before connecting
or disconnecting a module. Failure to observe this precaution may cause faults or
malfunctions of the module.

- Tighten the screws of the terminal ports and the screws of the connectors within the
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires
and cause malfunctions. Excessive tightening can damage the screws and / or the
module, with the risk of falling, short circuits and malfunctions.

- Before handling a module, dispose of the electrostatic charge accumulated by the
human body by touching a suitable conductive object. Failure to observe this
precaution may cause faults or malfunctions of the module.

Repair note:

If the equipment is suitable to be repaired, it must be verified that the equipment
remains in a safe state after repair.
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15. Revision Table

Revision Number
0

Date
18/03 /2020

Rev.0: 18-03-20

Changes
It was first implemented
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About Industrial Shields:

Direction: Fabrica del Pont, 1-11

Zip/Postal Code: 08272

City: Sant Fruités de Bages (Barcelona)

Country: Spain

Telephone: (+34) 938 760 191 / (+34) 635 693 611

Mail: industrialshields@industrialshields.com

Rev.0: 18-03-20
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